Tutorial

How do I build a model in Enterprise Architect?
Follow this tutorial to build a simple model in a
Firebird Repository, using Enterprise Architect.
# Table of Contents

- **Tutorial** ........................................................................................................ 4
- **Startup** ........................................................................................................ 6
- **Create a Project** .......................................................................................... 9
- **Add a View to your Model** .......................................................................... 12
- **Add New Packages** ................................................................................... 14
- **Create a New Diagram** ............................................................................... 17
- **Create New Elements on a Diagram** ....................................................... 20
- **Add Connectors** ........................................................................................ 24
- **Modify Properties** ..................................................................................... 27
- **Save Changes** ............................................................................................. 29
- **Copy Elements Between Packages** .......................................................... 30
- **Move Objects Around** ............................................................................... 33
  - **Move Objects Within a Package** ............................................................. 35
  - **Move Objects Between Packages** .......................................................... 37
  - **Move Elements in a Diagram** .................................................................. 39
  - **Move Elements Between Diagrams** ...................................................... 41
  - **Connect a Different Element on a Diagram** ......................................... 43
- **Delete a Connector** .................................................................................. 45
- **Delete an Element** .................................................................................... 49
  - **Remove Elements From a Diagram** ....................................................... 50
  - **Delete Elements From Your Model** ...................................................... 52
Welcome to Enterprise Architect!

This quick-start tutorial helps you get up to speed with Enterprise Architect.

As you read through this tutorial, it is recommended that you have Enterprise Architect open so that you can try out the tasks described. By the end you should be able to begin modeling your own business/software projects with Enterprise Architect.

Throughout the descriptions there are hyperlinks to more detailed information on a range of topics.

Basic Tasks

<table>
<thead>
<tr>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a new project</td>
</tr>
<tr>
<td>Adding Views to your model</td>
</tr>
<tr>
<td>Adding Packages to your model</td>
</tr>
<tr>
<td>--------------------------------</td>
</tr>
<tr>
<td>Adding diagrams</td>
</tr>
<tr>
<td>Adding elements to your model Packages</td>
</tr>
<tr>
<td>Creating links between model elements</td>
</tr>
<tr>
<td>Refining the model</td>
</tr>
</tbody>
</table>
Startup

When you install Enterprise Architect on your system, two items are created:

- An Enterprise Architect icon on your Windows desktop
- A new program folder called Enterprise Architect <version number> in your Windows 'Start > All Programs' menu; this folder contains the execution option 'Enterprise Architect'

You can start Enterprise Architect by clicking on either of these objects. After a short pause, the Start Page displays, from which you can:

- Open a project file (.eap file, .eapx file or .feap file)
- Create a new project (.eap file, .eapx file or .feap file)
- Connect to a DBMS repository (Corporate and extended editions)
- Connect to a project via the Cloud (Corporate and extended editions)
- Return directly to one of the projects you most recently opened
- Open one of a number of Portals to a set of facilities that support an area of work in Enterprise Architect

Notes

- If you changed the default system folder name during
installation, the Enterprise Architect <version number> folder in the 'All Programs' menu will have the name you provided

- By default, when you install Enterprise Architect, an empty 'starter' project called EABase.eap is installed, as well as an example project named EAExample.eap; we recommend that new users select the EAExample file and explore it in some detail while they become familiar with UML and software engineering using Enterprise Architect

- Enterprise Architect .eap files default to use JET 3.5 as the database engine, which does not support unicode character sets

- Enterprise Architect .eapx files default to use Jet 4.0 as the database engine, which does support unicode character sets (for example, to provide user interface texts in languages other than your Windows-defined native language)

- If you want to use unicode character sets, you must either upsize to a DBMS repository or set JET 4.0 as the database engine; resetting the database engine ensures compatibility with .eap files that support unicode character sets and that are in turn compatible with versions of MS Access later than Access 97

- If your .eap project is not in a Jet 4.0 database, you should also download a copy of the Jet 4.0 EABase model from the Sparx Systems website, and do an EAP to EAP transfer of your model into the Jet 4.0 file
Create a Project

A project is a single file or repository-based store for one or more models.

- The first step in getting started with Enterprise Architect is to either open an existing project, or create a new one
- In this example we create a new file-based project and add a template-based model to kick-start our modeling
- Once your new project has been created it will have a simple Use Case model added for you to explore and tailor to your requirements
- You can re-open your project at any time by double-clicking on it in a file browser
- It should also appear in the 'Recent' list on the Start Page

Create a New Project

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start Enterprise Architect.</td>
</tr>
<tr>
<td>2</td>
<td>When the 'Start' page displays, click on the 'New File' option. Result: The standard Windows file browser dialog displays.</td>
</tr>
</tbody>
</table>
File-based Enterprise Architect projects are named with:

- A .eap extension (JET 3)
- A .eapx extension (JET 4)

You can also create projects on Firebird by clicking on the drop-down arrow in the 'Files of type' field and selecting the '* .feap' option.

3. Locate a suitable folder for your project and, in the 'File name' field, type in a distinctive name. Click on the Save button to continue.

Result: Enterprise Architect creates a new project file and places it in the specified location.

The project is then opened automatically. The 'Project' tab of the Browser window displays with the 'Model' icon at the top.

4. Click on the icon in the Browser window toolbar; the Model Wizard window displays, showing the 'Model Patterns' tab.

In the left hand column header, click on the drop-down arrow and select 'UML > Behavioral' and scroll down to 'Use Case Diagrams'. Select 'Basic Use Case Model'.

Click on the Create Patterns button.

Result: The Model Wizard automatically creates a new Use Case model for you, with an initial diagram, some notes and default elements to help get
you started.

5 Close the Model Wizard window. At this stage all your changes have been saved to file and do not require further action.
Add a View to your Model

A View is a top level Package within a model. It can be categorized by purpose, such as Use Case View, Component View or Deployment View, the purpose being indicated by using different types of icon. Views are used to add an optional level of grouping of Packages, diagrams and elements - the building blocks of your model.

Add a View

<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the 'Project' tab of the Browser window, right-click on the 'Model' icon (the model root node) and select the 'Add View' option. The 'Create New View' dialog displays.</td>
</tr>
<tr>
<td>2</td>
<td>In the 'Name' field, type an appropriate name for the new View.</td>
</tr>
<tr>
<td>3</td>
<td>Click on the appropriate radio button to select an icon for the View (we suggest Simple).</td>
</tr>
<tr>
<td>4</td>
<td>Click on the OK button. The 'Create New View' dialog closes.</td>
</tr>
</tbody>
</table>
The new View is created as a child of the Model root node.

Notes

- There are six types of View, which represent conventional ways of categorizing the purpose of a Model View; these types of View represent different structural or behavioral aspects of the same model.
Add New Packages

A Package is a container of model elements, and is represented in the Browser window as a 'folder' icon.

- A Package holds the model building blocks, such as diagrams, elements and other Packages
- To begin developing your model, you create an initial Package to hold your first diagrams and model structures

Access

There are numerous ways in which you can add a Package to your model. Start by selecting the parent Package (or View or Root node) in the Browser window.

Then choose any of the methods outlined here.

<table>
<thead>
<tr>
<th>Ribbon</th>
<th>Design &gt; Model &gt; Add &gt; Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context Menu</td>
<td>Right-click on parent Package</td>
</tr>
<tr>
<td></td>
<td>Add a Package</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>Other</td>
<td>Browser window tool bar</td>
</tr>
</tbody>
</table>
Add a Package to your model

On the 'New Package' dialog, complete the fields as instructed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Displays the name of the currently-selected Package or View, to which you are adding the new Package. If this is not the required owner Package, click on the button and select the correct Package.</td>
</tr>
<tr>
<td>Name</td>
<td>Defaults to Package1. Overtype this with the name of the new Package.</td>
</tr>
<tr>
<td>Select and Apply Model Pattern</td>
<td>Click on this radio button if you want to create the new Package from a Model Pattern.</td>
</tr>
<tr>
<td>Create Diagram</td>
<td>Click on this radio button if you want to immediately create a child diagram for the Package.</td>
</tr>
<tr>
<td>Package Only</td>
<td>Click on this radio button if you want to just create a Package.</td>
</tr>
</tbody>
</table>
| **OK** | Click on this button to create the Package in the Browser window.  
If you selected the 'Select and Apply Model Pattern' radio button, the Model Wizard view displays. Select the appropriate Perspective and Model Pattern to import. Click on the OK button.  
If you selected the 'Create Diagram' radio button, the 'New Diagram' dialog displays. Type in a name for the diagram and select the appropriate Perspective Group and Perspective (in the 'Select From' panel) and the required diagram type. Click on the OK button.  
The new Package is inserted into the Browser window under the selected parent Package or View. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cancel</strong></td>
<td>Click on this button to abort the changes you have made and close the dialog.</td>
</tr>
</tbody>
</table>
Create a New Diagram

A diagram is a visual representation of the elements of your model and:

- Their attributes and characteristics
- How they are connected and/or interact with each other

Different diagram types show different aspects of the model and the relationships between elements.

Add new diagrams to your model

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Click on a Package or View in the Browser window, then either:  
- Click on the Browser window button, or  
- Press Ctrl+Insert, or  
- Select the 'Design > Diagram > Add' ribbon option, or  
- Right-click on the Package or View and select the 'Add Diagram' option  
The 'New Diagram' dialog displays. |
<p>| 2    | Enterprise Architect provides a default diagram name that is the same as the parent Package name. |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Overtype this with your preferred diagram name, if necessary.</td>
</tr>
<tr>
<td>3</td>
<td>Click on the 'Select From' header and select the Perspective Group and Perspective most appropriate to the area you are working in. The panel below the header displays a list of diagram groups; click on the required group.</td>
</tr>
<tr>
<td>4</td>
<td>In the 'Diagram Types' panel, click on the type of diagram to create. A description of the selected diagram type displays in the field underneath this pane.</td>
</tr>
</tbody>
</table>
| 5 | Click on the OK button.  
- The 'New Diagram' dialog closes  
- A new diagram is created as a child of the currently selected Package  
- The new diagram is opened in the Diagram View, ready for editing |

**Notes**

- When you create a Package, if you leave the 'Create Diagram' option selected, the 'New Diagram' dialog displays automatically
Create New Elements on a Diagram

Models are constructed from elements, each of which has its own meaning, rules and notation. Generally, when you create a new element in your model, you want to use that element on a diagram. The simplest way to do this is to create the element directly on the diagram. In this procedure, we will use a Requirement element as the example.

Create a new element on a diagram in your model

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Display the Properties window; select the 'Start &gt; Desktop &gt; Design &gt; Properties' ribbon option. Also display the Diagram Toolbox; select the 'Design &gt; Diagram &gt; Toolbox' ribbon option</td>
</tr>
<tr>
<td>2</td>
<td>Display the diagram on which the elements are to be created, in the Diagram View. To open the diagram, double-click on the diagram name in the Browser window. The diagram opens and the Toolbox is updated to display the categories of elements and relationships</td>
</tr>
</tbody>
</table>
that are applicable to that type of diagram. In this example, we must change this to the Custom toolbox. Click on to display the 'Find Toolbox Item' dialog, and specify 'Custom'.

3 Click on the appropriate icon in the Toolbox to select the type of element to create (in this example, the Requirement element). The element type is highlighted in the Toolbox.

4 Click on the diagram at the location where you want to place the element.

The new element is created as a child of the Package that contains the diagram, and is placed onto the diagram at the cursor position. The element's initial details are displayed in the Properties window.

5 Use the Properties window to define the element's name and other properties it should have.
6 Right-click on the diagram background and select the 'Save Current Changes' option.
Notes

- You can also drag or paste existing elements onto a diagram from the Browser window.
- If you are creating several elements of one type, after creating the first just press Shift+F3 or Ctrl+click to create the next element of that type.
- You can also create elements using shortcuts to the main facilities of the Toolbox, using the 'Toolbox Shortcut' menu; to display this menu press the Insert key or Spacebar key, or hold the left mouse button and click the right mouse button.
Add Connectors

Connectors define specific relationships between specific elements, so you usually create them directly on the diagram by dragging the required relationship type from the Diagram Toolbox. As for elements, the Toolbox automatically presents the connector or relationship types appropriate to the type of diagram currently displayed.

Define a relationship between two model elements on a diagram

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Display the Diagram Toolbox; either:  
    • Select the 'Design > Diagram > Toolbox' ribbon option or  
    • Press Ctrl+Shift+3  
    Also, if it is not already displayed, open the Properties window ('Start > Desktop > Design > Properties' ribbon option). |
| 2    | Open the diagram containing the elements to be connected, in the Diagram View (double-click on the diagram name in the Browser window). |
The selected diagram opens and the Toolbox is updated to display the categories of elements and relationships that are applicable to that diagram type.

3 Click on the required connector in the Toolbox to select the type of connector to draw. The connector type is highlighted in the Toolbox.

4 Click on the source element in the relationship, then drag across to the target element. The selected connector is drawn between the two elements. The connector becomes the focus of the Properties window.

5 Use the Properties window to define the characteristics of the connector as required.

Notes

- If you are creating several connectors of one type, after creating the first just click on the appropriate source element and press F3 to create the next connector of that type
- As you drag a connector path, you can press Shift to create a bend in the connector; if necessary, you can put
several bends in the connector line, pressing Shift every time you want to change direction

- To roll back the bends, keep holding the left mouse button down and press the Backspace key as many times as is necessary
- To find out more about the type of connector you have dragged on to a diagram, right-click on the connector and select the 'Type Information' option, which displays a Help page on the connector type
Modify Properties

When you create an element and connect it to another element, you usually have to define various characteristics of both the element and the connector to identify the purpose and function they represent. You do this using the Properties window.

When you create elements, Enterprise Architect automatically names and numbers them by type - for example, Class1, Class2 - so you should at least change the 'Name' field to more easily identify each element. Enterprise Architect does not automatically name connectors, but for many connector types you can provide a name that describes the purpose of the connection.

Modify the characteristics of a model element or connector

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the 'Start &gt; Desktop &gt; Design &gt; Properties' ribbon option. The Properties window displays. Click on the element or connector for which to define properties. The initial details for that object display in the Properties window.</td>
</tr>
</tbody>
</table>
2 Modify the element or connector characteristics as required.

3 Click on the diagram background. The element or connector details in the window are saved; the diagrams that contain the element or connector are updated as necessary, as is the Browser window.

Notes

- You can also modify the properties of an element or connector using the 'Properties' dialog, which is specific to the selected object; select:
  - For an element, the 'Design > Element > Editors > Properties Dialog' ribbon option or
  - For a connector, right-click on the connector and select the 'Properties' menu option
- On the 'Properties' dialog, click on the OK button to save the changes and close the dialog
Save Changes

Throughout much of your work in Enterprise Architect, any changes you make are automatically saved when you close the dialog (data entry window) on which you made the changes. In some cases the dialog contains a Save button or Apply button, which you can click on to save your changes and then keep working on the dialog.

**If there is no specific dialog, such as when you create a diagram, you can save your work by**

- Clicking on the Save icon in the Diagram toolbar
- Pressing the Ctrl+S keyboard keys, or
- Right-clicking on the diagram and selecting the 'Save Current Changes' menu option

Often, Enterprise Architect does not let you close a screen without confirming that you want to save or discard your changes. You can also save your diagram changes automatically, by selecting the 'Auto Save Changes' checkbox on the 'Diagram Behavior' page of the 'Preferences' dialog.
# Copy Elements Between Packages

You can quickly and easily duplicate one or more elements, with their child elements and diagrams, across Packages. You can insert a copy of an element under one or more other Packages, in the same project file or any other project file.

## Operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy the Elements</td>
<td>In the Browser window, select the elements to copy, right-click on one and select:</td>
</tr>
<tr>
<td></td>
<td>'Copy / Paste</td>
</tr>
<tr>
<td></td>
<td>Alternatively, click on a selected element and press Ctrl+Shift+C. The 'Copying Selected Element(s) to Clipboard' dialog briefly displays while the copy operation completes.</td>
</tr>
<tr>
<td>Paste the Elements</td>
<td>In the Browser window, right-click on the Package into which to paste the copied elements, and select the 'Copy / Paste</td>
</tr>
</tbody>
</table>
press Ctrl+V. The 'Pasting Element(s) from Clipboard' dialog briefly displays while the paste operation completes.

The target Package is expanded and the pasted elements are exposed in the Browser window. If you are pasting the elements within the same model as the copied source, the source parent Package is also collapsed.

If the target Package already contains:

- An element of the same type with the same name as a pasted element, the pasted element name has the suffix - Copy
- An element with the same type and name as the pasted element including the - Copy suffix, the suffix becomes - Copy1 (or - Copy2, - Copy3 and so on, as copies of the element accumulate in the target Package)

You can keep the same element names as the source, or you can rename each element either by clicking twice on it and editing the name in the Browser window, or by double-clicking on it and editing the name in the 'Properties' dialog.
Notes

- A copy of an element does not have the external cross references of the source element; that is:
  - if one element is copied it has no connectors
  - if more than one element is copied, only the connectors between the copied elements are retained
  - however, if those elements come from a Sequence or Communication diagram and the diagram itself is not copied, the message connectors between the copied elements are not retained

- You cannot paste an element into a Package that is locked by another user or that is checked in; the 'Paste...' option is grayed out in the context menu
Move Objects Around

You have created a project containing Packages, diagrams and elements, and you have connected the elements. How do you change where things are?

Move diagrams, elements and connectors

<table>
<thead>
<tr>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the Browser window list order - re-arrange the order of items in the Browser window</td>
</tr>
<tr>
<td>Move elements between Packages - move diagrams, elements and child Packages from one parent Package to another</td>
</tr>
<tr>
<td>Move elements on a diagram - re-arrange the position of diagram elements</td>
</tr>
<tr>
<td>Move elements between diagrams - cut an element from one diagram and paste it onto another</td>
</tr>
<tr>
<td>Move connectors on a diagram - re-link a source element to a different target element</td>
</tr>
</tbody>
</table>
Move Objects Within a Package

In the Browser window, the contents of a Package are listed in the order: diagrams, child Packages, elements.

- Elements are further arranged in order of type (but see Notes)
- Within a type, components are initially listed in alphabetical or numerical order
- You can change the order in which items are listed within their groups

Adjust the order in which items are listed in the Browser Window

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click on an item in the Browser window, then click on ( \uparrow ) or ( \downarrow ) in the toolbar at the top of the window. The selected item is moved up or down in the Browser window accordingly, but remains within its particular group of items.</td>
</tr>
<tr>
<td>2</td>
<td>To revert to listing components in alphabetical order, in the Browser window right-click on the Package and select the 'Contents</td>
</tr>
</tbody>
</table>
Notes

- You can re-arrange elements in your preferred sequence regardless of type, by selecting the 'Allow Free Sorting' checkbox on the 'General' page of the 'Preferences' dialog.
Move Objects Between Packages

When creating the various diagrams, elements and Packages that make up your model, at some point you might create one of these objects under the wrong parent Package. It is quite simple to relocate a model object from one Package to another, either to a higher level Package, a lower level Package or a different Package at the same level.

Move objects between Packages

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Browser window, click on and drag the model item to be relocated from its existing position, and drop it onto the new parent Package. The dragged item and all of its child items are relocated to the target Package.</td>
</tr>
</tbody>
</table>

Notes

- Moving elements in the Browser window does not affect the use of elements in diagrams
- Moving an element or Package has no effect on any relationships that the element, Package, or elements within the Package have.
- Moving a diagram generally does not affect the location of elements in Packages.
- However, elements of certain types, such as Initial Node, Decision and Final Node, are used only within one diagram and have no meaning outside that diagram; if you move a diagram containing these elements, they are moved to the new parent Package with the diagram.
Move Elements in a Diagram

To improve the understanding of a diagram or to simply improve the presentation, you might want to adjust the position of the elements on your diagram.

For coarse adjustments

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click on a diagram element and drag it to its new position.</td>
</tr>
</tbody>
</table>

For fine adjustments

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click on a diagram element to select it.</td>
</tr>
<tr>
<td>2</td>
<td>While holding down the Shift key, press the keyboard arrow keys to move the selected element one pixel at a time in the direction of the arrow.</td>
</tr>
</tbody>
</table>
Move Elements Between Diagrams

If an element is present in one diagram but actually belongs in another, you can simply move the element from the first diagram into the second. You can also cut multiple elements from one diagram and paste them into another. When you cut elements from a diagram, the elements are held on the clipboard but are not cleared from the source diagram until they are specifically pasted into the target diagram. A moved element is not affected in any other way.

Access

Open the diagrams:

- Containing the element(s) to be moved, and
- Into which the elements(s) will be moved

<table>
<thead>
<tr>
<th>Keyboard Shortcuts</th>
<th>With the element selected in the source diagram:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>· Ctrl+X</td>
</tr>
</tbody>
</table>

|                      | With the cursor in the target diagram:           |
|                      | · Ctrl+V or Shift+Insert                         |

| Other               | Display the 'Default Tools' Toolbar (Explore > Portals > Show Toolbar > Default Tools) and: |
|                     | · On the source diagram, click on the           |
element to be moved and on the icon in the Toolbar

- Click on the target diagram and on the icon in the Toolbar

**Notes**

- By selecting more than one element at a time, you can move multiple elements in the same operation
Connect a Different Element on a Diagram

When creating connectors in your diagrams, at some point you might connect the wrong pair of elements. Enterprise Architect provides a simple method to help you to move the end of a connector from one element to another; that is:

- Change the source element of a connector from the current element to another, or
- Change the target element of a connector from the current element to another

Change a connected element

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the diagram, click on the connector to select it. The connector is highlighted with 'handles' at each connector end.</td>
</tr>
<tr>
<td>2</td>
<td>Move the cursor over the 'handle' at the end of the connector to reconnect. The cursor changes to a small arrow pointing upwards to the right.</td>
</tr>
</tbody>
</table>
3 Click on and drag the connector end to the other element to connect to. When you release the mouse button, the connector breaks from the original element and reconnects to the new element.

Notes

- You can also tidy up a connection by dragging the end of the connector to a better position on the edge of the element, or move both ends at once by dragging the middle of the connector.
Delete a Connector

It is possible to hide a connector on a diagram, or to delete it entirely from the model, removing the relationship between the previously connected elements.

Displaying all of the connectors on a complex diagram can make the diagram somewhat confused, so it can be useful to hide some of the connectors, to clarify a specific aspect of a more complex picture.

Hide or remove a connector between two elements

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Open the diagram containing the connector of interest.  
      Either:  
      • Double-click on the diagram name in the Browser window, or  
      • Make an already open diagram the 'active' diagram, by clicking on its tab in the Diagram View |
| 2    | Click on the connector in the diagram to select it. |
The selected connector is highlighted in the diagram.

3  Either:
   • Press Ctrl+Delete
   • Right-click on the connector and select the 'Delete Connector' option, or
   • Press the Delete key
If you press Ctrl+Delete, a dialog displays prompting you to confirm that you want to delete the connector (and the relationship it describes) from the model. Click on the Yes button to remove the connector.
   The Delete key and 'Delete Connector' option display the 'Remove Connector' dialog.

4  On the 'Remove Connector' dialog, choose one of the options:
   • Hide the connector or
   • Delete the connector from the model
   'Hide the connector' obscures the connector on the current diagram; you cannot see it but the relationship between the two elements still exists and is shown on other diagrams containing the two elements together, and on all reports of connectors between the elements.
   'Delete the Connector from Model' removes the relationship that exists between the two elements; the connector is removed from the current diagram, from all other diagrams on which it is shown, and
from all reports on connectors between the two elements.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>5</strong></td>
<td>Optionally, tick the checkbox 'Don't ask again'. Selecting this option prevents the 'Remove Connector' dialog from being displayed next time you select the 'Delete Connector' command; the command uses the setting you last used on the dialog. Make sure that you have selected the right option to use as your default.</td>
</tr>
<tr>
<td><strong>6</strong></td>
<td>Click on the OK button. The connector disappears from the diagram. If you selected the 'Delete the connector from the model' option, the relationship represented by the connector is also deleted from your model.</td>
</tr>
</tbody>
</table>

**Notes**

- You cannot select multiple connectors - it is only possible to select one connector at a time
- If you select the 'Don't ask again' checkbox on the 'Remove Connector' dialog, you can reset this option on the 'Links' page of the 'Preferences' dialog ('Start > Desktop > Preferences > Preferences > Links' ribbon
option, select the 'Prompt on connector delete' checkbox)

- Selecting the 'Hide the connector' option in the 'Remove Connector' dialog has the same effect as using the 'Visibility | Hide Connector' context menu option on the connector
Delete an Element

You can delete the elements of a model from a diagram or from the Browser window.

Delete an element

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove elements from a diagram: this is essentially 'hiding' the element in that particular view of the model.</td>
</tr>
<tr>
<td>Delete elements from a model - the element, its properties and any child elements or diagrams it has are all deleted; the element is removed from all diagrams on which it appears.</td>
</tr>
</tbody>
</table>
Remove Elements From a Diagram

Removing an element from a diagram does not delete the element from the model and therefore does not alter the structure of the underlying model. When you remove an element from a diagram, you are essentially 'hiding' the element in that particular view of the model.

Remove elements from a diagram

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Open the diagram that is to be modified. Either:  
|      | • Double-click on the diagram name in the Browser window, or  
|      | • Make an already open diagram the 'active' diagram, by clicking on its tab in the Diagram View |
| 2    | Either:  
|      | • Press Ctrl+A to select all of the elements in the diagram, or  
|      | • Click on an element in the diagram to select it (and use Ctrl+click to add further elements to your selection, or to remove elements from the
The selected elements are highlighted in the diagram.

<table>
<thead>
<tr>
<th>3 Either:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press the Delete key, or</td>
</tr>
<tr>
<td>Press Ctrl+D, or</td>
</tr>
<tr>
<td>Right-click a selected element and select the 'Delete &lt;element name&gt; ' or 'Delete Selected Elements' option</td>
</tr>
</tbody>
</table>

The selected elements are removed from the diagram.

### Notes

You can 'undo' the removal of a diagram element, by pressing Ctrl+Z, or by clicking the Undo button in the Default Tools toolbar.
Delete Elements From Your Model

You can delete elements from your model, working either from the Browser window or from a diagram.

- When you delete an element from your model, the element, its properties and any child elements or diagrams it contains are all deleted
- The deleted element is removed from all diagrams on which it appears
- All relationships that it was involved in are also deleted from the model

Delete one or more items from your model using the Browser window

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Browser window, click on an item to select it. To select additional items, or to remove items from the selection, use Ctrl+click or Shift+click. The selected items are highlighted in the Browser window.</td>
</tr>
</tbody>
</table>
| 2    | Either:  
- Press Ctrl+Delete or |
Right-click on one of the selected elements, then select the 'Delete selected item(s)' option. A confirmation dialog displays.

3. Click on the Yes button. The selected items are deleted from your model.

Delete one or more items from your model using a diagram

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | To open the diagram containing the items to be deleted from your model, either:  
|      | - Double-click on the diagram name in the Browser window, or  
|      | - Make an already open diagram the 'active' diagram, by clicking on its tab in the Diagram View |
| 2    | Either:  
|      | - Press Ctrl+A to select all of the elements in the diagram, or  
|      | - Click on an element in the diagram to select it, |
then use Ctrl+click to add or remove specific elements to and from the selection
The selected elements are highlighted in the diagram.

3 Press Ctrl+Delete.
A confirmation dialog displays.

4 Click on the Yes button.
The selected elements are removed from the model.

Notes

- Deleting a Package completely removes the Package and all its contents - diagrams, child Packages and elements - from the model
- Deleting an element completely removes the element and its properties, connectors, child elements and child diagrams from the model, and from every diagram that contains it
- Deleting a diagram completely removes the diagram from the model, but not the diagram's component elements; they remain in the parent Package